AVAYA

Avaya Solution & Interoperability Test Lab

Application Notes for Configuring Telecom Liechtenstein SIP
Trunking Service with Avaya IP Office 10 and Avaya Session
Border Controller for Enterprise Release 7.1 - Issue 1.0

Abstract

These Application Notes describe the procedures for configuring Telecom Liechtenstein
Session Initiation Protocol (SIP) Trunking with Avaya IP Office Release 10 and Avaya
Session Border Controller for Enterprise Release 7.1.

Telecom Liechtenstein SIP Trunking provides PSTN access via a SIP trunk between the
enterprise and the Liechtenstein network as an alternative to legacy analog or digital trunks.
This approach generally results in lower cost for the enterprise.

Readers should pay attention to Section 2, in particular the scope of testing as outlined in
Section 2.1 as well as the observations noted in Section 2.2, to ensure that their own use cases
are adequately covered by this scope and results.

Telecom Liechtenstein is a member of the Avaya DevConnect Service Provider program.
Information in these Application Notes has been obtained through DevConnect compliance
testing and additional technical discussions. Testing was conducted via the DevConnect
Program at the Avaya Solution and Interoperability Test Lab.
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1. Introduction

These Application Notes describe the procedures for configuring Session Initiation Protocol (SIP)
Trunking between service provider Telecom Liechtenstein (Liechtenstein) and the Avaya IP Office
solution. In the sample configuration, the Avaya IP Office solution consists of an Avaya IP Office
Server Edition release 10, Avaya Session Border Controller for Enterprise release 7.1 (Avaya
SBCE), Avaya IP Office Embedded VVoicemail, Avaya Communicator for Windows, and Avaya
H.323, SIP, digital, and analog endpoints.

The Telecom Liechtenstein SIP Trunking service referenced within these Application Notes is
designed for business customers. The service enables local long distance and international PSTN
calling via standards-based SIP trunks as an alternative to legacy analog or digital trunks, without the
need for additional TDM enterprise gateways and the associated maintenance costs.

2. General Test Approach and Test Results

The general test approach was to configure a simulated enterprise site using Avaya IP Office to
connect to Telecom Liechtenstein SIP Trunking service via the Avaya SBCE. This configuration
(shown in Figure 1) was used to exercise the features and functionality tests listed in Section 2.1.

DevConnect Compliance Testing is conducted jointly by Avaya and DevConnect members. . The
jointly-defined test plan focuses on exercising APIs and/or standards-based interfaces pertinent to
the interoperability of the tested products and their functionalities. DevConnect Compliance Testing
is not intended to substitute full product performance or feature testing performed by DevConnect
members, nor is it to be construed as an endorsement by Avaya of the suitability or completeness of
a DevConnect member’s solution.

2.1. Interoperability Compliance Testing

A simulated enterprise site with Avaya IP Office was connected to Liechtenstein SIP Trunking
service via the Avaya SBCE. To verify SIP trunking interoperability, the following features and
functionality were exercised during the interoperability compliance test:

e Response to SIP OPTIONS queries.

e SIP trunk registration and authentication.

e Incoming PSTN calls to various phone types. Phone types included H.323, SIP, digital, and
analog telephones at the enterprise. All inbound PSTN calls were routed to the enterprise
across the SIP trunk from the service provider.

e Outgoing PSTN calls from various phone types. Phone types included H.323, SIP, digital,
and analog telephones at the enterprise. All outbound PSTN calls were routed from the
enterprise across the SIP trunk to the service provider.

¢ Inbound and outbound long holding time call stability.

e Various call types including: local, long distance, international, outbound toll-free, operator
service and directory assistance.

e Codec G.711A and G.729.

e Caller number/ID presentation.
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e Privacy requests (i.e., caller anonymity) and Caller ID restriction for inbound and outbound
calls.

DTMF transmission using RFC 2833.

Voicemail navigation for inbound and outbound calls.

Telephony features such as hold and resume, transfer, and conference.

Fax G.711 Pass Through modes.

Off-net call forwarding.

Twinning to mobile phones on inbound calls.

Avaya Communicator for Windows.

Avaya Communicator for Web client (WebRTC).

Remote Worker which allows Avaya SIP endpoints to connect directly to the public Internet as
enterprise phones.

Note:

Remote Worker and Avaya Communicator for Web (WebRTC) were tested as part of this solution.
The configuration necessary to support remote worker and Avaya Communicator for Web is beyond
the scope of these Application Notes and are not included in these Application Notes. For these
configuration details, see Reference [8] and [9].

2.2. Test Results
Liechtenstein SIP Trunking passed compliance testing.

Items supported or not tested included the following:
e Fax T.38 is not supported by Liechtenstein system.

Interoperability testing of Liechtenstein SIP Trunking was completed with successful results for all
test cases with the exception of the observations/limitations described below.

e Call Redirection (Blind and Consultative Transfer) Using re-INVITE Method —
Inbound PSTN call to Avaya IP Office endpoints being transferred off-net to another PSTN
endpoint resulted in no ring back tone and no audio path. This issue caused by Avaya SBCE
not forwarding the 2000K, responding to INVITE of second call leg, from service provider
to IP Office. This issue was resolved by applying Avaya SBCE hot-fix patch; sbce-7.1.0.1-
07-12090-hotfix-12062016. This hot-fix patch will also be integrated into Avaya Avaya
SBCE service update, SP2.

e Call Redirection (Call Forward Off-Net) Using REFER Method — Inbound call from
PSTN to an IP Office endpoint got forwarded off-net to another PSTN endpoint, IP Office
system responded to NOTIFY (Trying) with 405 Method Not Allowed instead of 2000K.
There was no user impacted. The call was forwarded successfully with 2-way audio.

e Call Redirection (Blind Transfer) Using REFER Method on H.323 Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office got transferred to/from another
PSTN destination, Liechtenstein system responded to second call leg INVITE with 480
Request Terminated to terminate the call instead of a BYE. There was no user impacted. The
call was transferred successfully with 2-way audio.

e Call Redirection (Blind Transfer) Using REFER Method on SIP Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office got transferred to/from another
PSTN destination, IP Office system responded to NOTIFY (Trying) with 405 Method Not
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Allowed instead of 2000K. There was no user impacted. The call was transferred
successfully with 2-way audio.

e Call Redirection (Consultative Transfer) Using REFER Method on H.323 Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office got transferred to/from another
PSTN destination, IP Office system responded to NOTIFY (Trying) with 405 Method Not
Allowed instead of 2000K. There was no user impacted. The call was transferred
successfully with 2-way audio.

e Call Redirection (Consultative Transfer) Using REFER Method on SIP Endpoint —
Inbound/outbound calls from/to PSTN to/from IP Office got transferred to/from another
PSTN destination, IP Office system responded to NOTIFY (Trying) with 405 Method Not
Allowed instead of 2000K. The SIP endpoint displayed transferred failed. The call was
transferred successfully with 2-way audio.

e Call Redirection (Consultative Transfer) Using REFER Method on Avaya
Communicator for Windows (ACW) — Inbound/outbound calls from/to PSTN to/from IP
Office ACW endpoint got transferred to/from another PSTN destination, IP Office system
responded to NOTIFY (Trying) with 405 Method Not Allowed instead of 2000K. The SIP
endpoint displayed transferred failed. The call was transferred successfully with 2-way
audio.

e Call Redirection (Blind Transfer) Using REFER Method on Avaya Communicator for
Web (WebRTC) — Inbound/outbound calls from/to PSTN to/from IP Office WebRTC
endpoint got transferred to/from another PSTN destination, IP Office system responded to
NOTIFY (Trying) with 405 Method Not Allowed instead of 2000K. The SIP endpoint
displayed transferred failed. The call was transferred successfully with 2-way audio.

2.3. Support

For technical support on the Avaya products described in these Application Notes, visit
http://support.avaya.com.

For technical support on Liechtenstein SIP Trunking, contact Liechtenstein at
http://www.telecom.li/de

3. Reference Configuration

Figure 1 below illustrates the test configuration. The test configuration shows an enterprise site
connected to the Liechtenstein SIP Trunking service via the Avaya SBCE through the public IP
network. For confidentiality and privacy purposes, actual public IP addresses used in this testing
have been masked out and replaced with fictitious IP addresses throughout the document.

Located at the enterprise site is an Avaya IP Office Server Edition with an Avaya IP 500 V2
Expansion System which provides connections for 16 digital stations and the extension PHONE 8
card which provides connections for 8 analog stations to the PSTN as well as 64-channel VCM
(Voice Compression Module) for supporting VolP codecs. The LAN port of Avaya IP Office is
connected to the enterprise LAN while the WAN port is connected to the public IP network via
Avaya SBCE. Endpoints include an Avaya 9600 Series IP Telephone (with H.323 firmware), Avaya
11x0 Series IP Telephone (with SIP firmware), an Avaya 9508 Digital Telephone, an Avaya
Symphony 2000 Analog Telephone and an Avaya Communicator for Windows. A separate
Windows PC runs Avaya IP Office Manager to configure and administer the Avaya IP Office.
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http://support.avaya.com/
http://www.telecom.li/de

Mobility Twinning is configured for some of the Avaya IP Office users so that calls to these user
phones will also ring and can be answered at the configured mobile phones.
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Figure 1: Test Configuration for Avaya IP Office with Liechtenstein SIP Trunking Service

For the purposes of the compliance test, this testing used Liechstenstein (Convoip Trunk FL in
Europe). For outbound call from Avaya system to PSTN, user dialed 6 following by 00 and 11 digits
including a 1 (Canada/US country code) since the testing was performed in North America
(Canada). The test used 00 plus the 11 digits number (i.e. 6 001 613 967 5204). For inbound call to
Avaya system from PSTN, user dialed international call beginning with 011 plus 10 digits number
provided by Liechtenstein (011 423 237 2780).
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4. Equipment and Software Validated

The following equipment and software/firmware were used for the sample configuration provided:

Avaya Telephony Components

Equipment

Release

Avaya IP Office Server Edition

10.0.01.0 build 53

Avaya IP Office 500v2 (Expansion)

10.0.0.1.0 build 53

Avaya IP Office Manager

10.0.0.1.0 build 53

Avaya IP Office Embedded Voicemail

10.0.0.1.0 build 53

Avaya Session Border Controller for
Enterprise (running on Portwell CAD-0208
platform)

7.1.0.1-07-12090
sbce-7.1.0.1-07-12090-patch-trunkauth
sbce-7.1.0.1-07-12090-hotfix-12062016

Avaya 11x0 IP Telephone (SIP)

SIP11x0e04.04.23.00

Avaya 9621G IP Telephone (H.323) 6.6.2.29.050316
Avaya Communicator for Windows 2.1.3
Avaya Communicator for Web (WebRTC) 1.0.16.2115
Avaya Digital Telephone (9508) 0.45
Avaya Symphony 2000 Analog Telephone N/A
Liechtenstein SIP Trunking Service Components
Component Release
Oracle SBC Net-Net 3820 6.40
Teles C5 Proxy 5.0.8.48-2

Note: The test results documented in these Application Notes apply to standalone IP Office V2
deployments as well as all configurations of IP Office Server Edition.
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5. Configure Avaya IP Office

This section describes the Avaya IP Office configuration to support connectivity to Liechtenstein
SIP Trunking service through Avaya SBCE. Avaya IP Office is configured through the Avaya IP
Office Manager PC application. From a PC running the Avaya IP Office Manager application, select
Start 2 Programs - IP Office - Manager to launch the application. Navigate to File > Open
Configuration, select the proper Avaya IP Office system from the pop-up window, and log in with
the appropriate credentials. A management window will appear similar to the one shown in the next
section. The appearance of the IP Office Manager can also be customized using the View menu. In
some screens presented in this section, the View menu was configured to show the Navigation pane
on the left side, the Group pane in the center, and the Details pane on the right side. Some of these
panes will be referenced in Avaya IP Office configuration. Proper licensing as well as standard
feature configurations that are not directly related to the interface with the service provider (such as
LAN interface to the enterprise site) is assumed to be already in place.

5.1. LAN Settings

In the sample configuration, the SEQT VM was used as the system name and the WAN port was
used to connect the Avaya IP Office to the public network. The LAN2 settings correspond to the
WAN port on the Avaya IP Office.

To access the LAN settings, first navigate to System (1) > SEQT VM in the Navigation pane and
then navigate to the LAN2 - LAN Settings tab in the Details pane.

Set the IP Address field to the IP address assigned to the IP Office WAN port.
Set the IP Mask field to the mask used on the public network.

All other parameters should be set according to customer requirements.

Click OK.

Configuration |7 SEQT VM* Bk -E X v <>

- R BOOTP (8)

£ VolP Security Contact Center
#1147+ Operator (3)

=153 Solution System LAN1 LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR  VolP
0@ User(30) LAN Settings VolP  Network Topol
+# Group() g o ork Topeology
+-@ Short Code(43) IP Address 10 10 97 &1
-~ Directory(0)
£ Tirme Profile(D) 1P Mask 253 . 255 . 255 . 240

----- il Account Code(0)
+-§3 User Rights(9)
‘i Location(D)

= SEQT VM

Yy

MNumber Of DHCP IP Addresses 200

=7 System (1) DHCP Mede
%59 SEQT VM
2% Line (2) (O Server (O Client (@ Disabled Advanced

= Control Unit (8)
-4 Extension (6)
4 User (M Help

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 7 of 56
SPOC 1/30/2017 ©2017 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



Select the Vol P tab as shown in the following screen.
e Ensure H323 Gatekeeper Enable box is unchecked.

e The SIP Trunks Enable box must be checked to enable the configuration of SIP trunks to
Liechtenstein.

e The Layer 4 Protocol, check the UDP, TCP and TLS boxes. Then set UDP and TCP Ports

to 5060, and TLS port to 5061.

e Enable RTCP Monitoring on Port 5005 and Keepalives should be set as shown in capture

below.
e All other parameters should be set according to customer requirements.
e Click OK.
Configuration = SEQTVM* Bt - s
+a BOOTP (8)

Operator (3)
Selution
£ User30)

System LANT  LAN2  DNS
LAN Settings VelP

Netwerk Topology

Voicemail Telephony Directory Services  System Events

SMTP  SMDR VolP

VolP Security Contact Center

: A
+ﬂ Group(1) [ H.323 Gatekeeper Enable
- @R Shor‘t Code(43) [] Auto-create Extension Auto-create User [] H.323 Remote Extension Enable
-1 Directory(0)
~£7) Time Profile(0) H.323 Signaling over TLS v 1720 E
B Account Code(0)
+-§5 User Rights(9)
i@ Location(0) SIP Trunks Enable
~%) SEQT VM .
= system (1) [ SIP Registrar Enable
=9 SEQT VM [ Auto-creste Extension/User [] SIP Remote Extension Enable
4 Line (2}
4“2 Control Unit (8) SIP Domain Name |
+@ Extension (6)
i-§ User(7) SIP Registrar FODN |
..... .u Group 0]
+-@% Short Code (50) UDP Port | 5060 = =
: @ Service (0]
@ Inceming Call Route (8) Layer 4 Protocel TCP Port 3060 = =
TLSPort |3061 = 061 =
- Account Code (0) Challenge Expiration Time (sec) <
% License (30)
+-§5 User Rights (9) RTP
" ARS (1)
.8 Location ) Port Number Range
"% Authorization Code (0) Minimum Maximum 30750 =
4555 |PO SP EXP
Port Number Range (MAT)
Minimum Maximum 30730 =
Enable RTCP Monitoring on Port 5005
RTCP collector IP address for phones
Keepalives
Scope ~ | Periodic timeout
Initial keepalives ~
v
£ >
oK Cancel Help
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On the Network Topology tab in the Details pane, configure the following parameters:

e Select the Firewall/NAT Type from the pull-down menu that matches the network
configuration. No firewall or network address translation (NAT) device was used in the
compliance test as shown in Figure 1, so the parameter was set to Open Internet. With this
configuration, STUN will not be used.

e Set Binding Refresh Time (seconds) to 60. This value is used as one input to determine the
frequency at which IP Office will send SIP OPTIONS messages to the service provider.

e Set Public IP Address to the IP address of IP Office WAN port. Public Port is set to 5060
for UDP and TCP, and 5061 for TLS.

e All other parameters should be set according to customer requirements.

e Click OK.

Configuration || ¥ SEQTVM"* g -9 [ X | v

=R BOOTP (8)
-4 Operator (3)
i---’-;-Sqution System LAN1 LANZ  DNS Voicemail Telephony Directory Services  System Events  SMTP SMDR VolP VolP Security
+-§  User(30)
+1§ Group(1)

Contact Center

LAN Settings VolP  Metwork Topology

+-9% Short Code(45) MNetwork Topology Discovery 2
STUN Server Address STUN Port 3478 =
i Accou.nt Code(0) Firewall/NAT Type Open Internet ~
T---ﬁ‘, User Rights(9)
i &5 Location(0) Binding Refresh Time (sec) 60 =
=I-%=p SEQT VM
= Public IP Address 10 0 97 61 Run STUN Cancel
: X Public Port
+-<2 Control Unit (8)
i Extension (6) upP 3060 =
+§ User (7) =
..... .,a Group (0) TCP 5060 -
+-@% Short Code (50) =
= @ Service (0) TLS 5061 2
+-§P) Incoming Call Route
: e - g ( [] Run STUN on startup v
7 Time Profile (0) a 5
-l P Route (1)
Bl Account Code (0)
B License (30) 0K Cancel Help
N WP

In the compliance test, the LANL1 interface was used to connect IP Office to the enterprise site IP
network. The LANL1 interface configuration is not directly relevant to the interface with
Liechtenstein SIP Trunking service, and therefore is not described in these Application Notes.
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5.2. System Telephony Settings

Navigate to the Telephony - Telephony Tab in the Details pane.
e Choose the Companding Law typical for the enterprise location. A-LAW is used as member
IS in Europe.
e Uncheck the Inhibit Off-Switch Forward/Transfer box to allow call forwarding and call
transfer to the PSTN via the service provider across the SIP trunk.
e Check the Drop External Only Impromptu Conference box to allow the host of the
conference leaving the active call and forcing all the parties off the conference as member

requested.
e Other parameters are left at default.
e Click OK.
Configuration | 7 SEQT VM" ™) v <>
+’! E]OOTE (9()3] System LANT  LANZ  DNS Voicemail Telepheny  Directory Services System Events SMTP  SMDR  VolP VolP Security Contact Center
4 perator
Selution Telephony  Park & Page Tones & Music Ring Tones  SM Call Log TUI
o-§  User (30) ) n
+ﬂ Group(1) Dial Delay Time (sec) 4 = Companding Law
+-@% Short Code(43) - Switch Line
- Directory(D) Dial Delay Count 0 -
£ Time Profile(0) -
.. Account Code(0) Default Mo Answer Time (sec) 15 = O U-Law U-Law Line
+§' User Rights(3) Hold Timeout (sec) 720 =
E Location(0) = i
-5 SEQT VM Park Timeout (sec) 300 = ® Adaw © A-LawLine
Ring Delay (sec) 5 =
[] DsS Status
1< Control Unit (8) Call Priority Promotion Time (sec) Disabled o
+@ Extension (6) [ Auto Held
+§“ gser(?m Default Currency usD ~ Dial By Name
roup - -
+g Short Code (51) Default Name Pricrity Faver Trunk Show Account Code
Service (0] . . . -
: Incoming Call Route Media Connection Preservation Enabled |:| Inhibit Off-Switch Forward/Transfer
Directory (0 i i w
Tilrr_:; ;gfgli([)) Phone Failback Automatic [ Restrict Metwork Interconnect
1 Legin Code Complexi
E f Routet(c‘lj de () Dg plexty Include location specific information
) ccount Lode Enforcement
W License (30) n = Drop External Only Impromptu Conference
i-§3 User Rights (9) -
- ARS (1) Complexity O Visually Differentiate External Call
i@ Location (0) ) X X X
m Authorization Code High Quality Conferencing

+-%59 |PO SP EXP RTCP Collector Configuration Directory Overrides Barring
L1 Send RTCP to an RTCP Collector [ Advertise Callee State To Internal Callers
£ > ’
OK Cancel Help
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5.3. VoIP Security Settings

When enabling SRTP on the system, the recommended setting for Media is Preferred. In this
scenario, IP Office uses SRTP if supported by the other end, and otherwise uses RTP. If the
Enforced setting is used, and SRTP is not supported by the other end, the call is not established.

Individual SIP lines and extensions have media security settings that can override system level
settings. This can be used for special cases where the trunk or extension setting must be different
from the system settings.

In the compliance testing, Preferred is set at system, trunk and extension level to allow the system to
fall back to non-secure media in case there is issue with SRTP. This would help to avoid blackout
situation within the enterprise network. In some specific deployments, if supported, Enforced is set
at the trunk level to ensure the secured communication over the public internet using both signaling
(TLS) and media (SRTP). Navigate to System = VolP Security tab and configure as follows:

e Select Preferred for Media Security. The system attempts to use secure media first and if

unsuccessful, falls back to non-secure media within the IP Office system.

e Check RTCP check-box.

e Other parameters are left as default.

e Click OK.

Configuration 7 SEQTVM* v |<]|>

:‘S E]OOTE (9()3J " System LANT LANZ DNS Voicemail Telephony Directory Services  System Events  SMTP  SMDR - VolP
t-{e« Operator

529 Solution VolP Security  Contact Center

#-§  User (30) ~
+,a Group(1) Media Preferred ~ [ Strict sIPS

8% Short Code(d5)
a8 Directory(0)
-7 Time Profile(0)
-l ACCUU_ﬂt Code(0) Media Security Options
T e Encrvotions e

-9 SEQT VM RTCP
S;‘:r ,St:%-g\?‘rm Authentication RTP
t-T4 Line (3) RTCP
+ -+ Contral Unit (8] Replav Protection

i Extension (§) SRTP Window Size [64
- User (7)

.,a Group (0) Crypto Suites

9% Short Cade (51) SRTP_AES_CM_128 SHAT_80
B Service (0) SRTP_AES_CM_128_SHA1_32
i Incoming Call Rou
#= [Directory (0)

7 Time Profile (0)
+ill IP Route (1)

i Account Cade (0) OK Cancel Help

5.4. Administer a SIP Line

A SIP line is needed to establish the SIP connection between IP Office and Liechtenstein SIP
Trunking service. The recommended method for configuring a SIP Line is to use the template
associated with these Application Notes. The template is an .xml file that can be used by IP Office
Manager to create a SIP Line. Follow the steps in Section 5.4.1 to create the SIP Line from the
template.
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Some items relevant to a specific customer environment are not included in the template or may
need to be updated after the SIP Line is created. Examples include the following:

e |P addresses.

e SIP Credentials (if applicable).

e SIP URI entries.

e Setting of the Use Network Topology Info field on the Transport tab.

Therefore, it is important that the SIP Line configuration be reviewed and updated if necessary after
the SIP Line is created via the template. The resulting SIP Line data can be verified against the
manual configuration shown in Section 5.4.2.

Also, the following SIP Line settings are not supported on Basic Edition:
e SIP Line — Originator number for forwarded and twinning calls.
e Transport — Second Explicit DNS Server.
e SIP Credentials — Registration Required.

Alternatively, a SIP Line can be created manually. To do so right-click Line in the Navigation Pane
and select New > SIP Line, then follow the steps outlined in Sections 5.4.2.

5.4.1. Create SIP Line from Template

1. Copy the template file to the computer where IP Office Manager is installed. Rename the
template file to TLSIPO10SBCE71.xml. The file name is important in locating the proper
template file in Step 4.

2. Import the template into IP Office Manager.
From IP Office Manager, select Tools = Import Templates in Manager. This action will
copy the template file into the IP Office template directory. The default template location is
C:\Program Files\Avaya\lP Office\Manager\Templates.

I Avaya IP Office Manager for Server Edition SEQT VM [10.0.0.1.0 build 53]
File Edit View | Tools | Help
] E Extension Renumber...
SEQT VM Export ’ .
; Server Edition Service User Management : :
Configurati SIP Line - Line 19
Busy on Held Validation
+“‘ BOOTP (2) redentials SIP Advanced Engineering
+-{# Operator (3) MEM Configuration
= Solution Print Button Labels -
+-§  User(30)
+ﬂ Group(1) | Import Ternplates in Manager | |
+-@% Short Code License Migration
a4 Directory(0) r—— |

In the resulting pop-up window that appears (not shown), select the directory where the
template file was copied in Step 1. After the import is complete, a final import status pop-up
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window will appear (not shown) stating success or failure. Next click OK (not shown) to
continue. If preferred, this step may be skipped if the template file is copied directly to the IP

Office template directory.

To create the SIP Trunk from the template, right-click on Line in the Navigation Pane, then

navigate to New - New from Template > Open from file.

Configuration |

—

SIP Line - Line

BOOTP (8)

O perator (3]

* Solution

& User(30)

g Group(1)}

~@¥ Short Code (45)
=m Directony (0]
00 Time Profile(0)
am Account Code(0)
3 User Rights(g9)
i Location ()

SIP Line Transport SIP URI WolP

Line Mumber

ITSP Domain Mame
Local Domain Mame
URI Type

Location

SIP Credentials SIP Adwvanced Engineering

Crl+ X
Ctrl+C
Crl+W
Ctri+Del

SIP

Clowud

Mew from Template

]

O pen from file

Export as Template

= 53 Mlew
N ' = Cut
E= Copy
- .. e Paste
-3 o Delete
g o Validate
=@ Sho |
- Servi
-4 Incoy
..... am Directory (00 |
S e ooy _son

CrEsSErTpEia

4. On the “Open” pop-up window, navigate to Manager = Templates and make sure
Template File (.xml) is the file type selected. Then select the file
“TLSIPO10SBCE71.xml”. Click Open and OK (not shown).

E Open

-

M <« Awvaya » |IP Offic

Organize « Mew folder

-~ Mame

 Quick access

I Desktop

“ Downloads

=] Documents

&=| Pictures
How to commar
IPO10SBCETT
IPO10SBCETT

template

I Desktop
@ OneDrive

& Quang

3 This PC
w

e » Manager ¥ manager_files » template

~ D Search temnplate =

de-DE

en-LUS

es-MX

fr-FR
IPSET-UMISTIM-CT7M
it-1T
LVMGreeting
manager_files
MemoryCards
nl-ML
Phonelmages
pt-BR

ru-RU
Templates

V3_2 990

zh-Hans

== -

m @

Type Size

File name:

b | Template Files (*xml)

Cancel

shown in Section 5.4.2.
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5.4.2. Create SIP Line Manually

To create a SIP line, begin by navigating to Line in the left Navigation pane and then right click to
select New > SIP Line. On the SIP Line tab in the Details pane, configure the parameters as

shown below:

e Set ITSP Domain Name to the ITSP domain so that IP Office uses this domain as the host
portion of SIP URI in SIP headers such as the From header.
e Check the In Service box.
e Check the Check OOS box. With this option selected, IP Office will use the SIP OPTIONS
method to periodically check the SIP Line.
e Incoming Supervised REFER is set to Auto to allow IP Office to support call transfer using
re-INVITE and REFER methods.
e Outgoing Supervised REFER is set to Auto to allow IP Office to support call transfer using
re-INVITE and REFER methods.
e Other parameters are set as default values.
e Click OK.

Configuration |

=

SIP Line - Line 2

- R BOOTP (10)
-4 Operator (3)

SIP Line Transport SIP URI VolP

SIP Credentials SIP Advanced Engineering

=% Solution Line Number 2 = In Service
+-§  User(31)
+1ﬂ Group(1) ITSP Domain Mame |tTDDDDDd.(on\rDip.|i | Check 005
+-8% Short Code(d3)
a8 Directory(0) Local Domain Name | |
£ Time Profile(0) Secsion Ti
-8 Account Code(D) URI Type SIP ~ ession limers
+% E;:;Elﬂg;@) Location Cloud w Refresh Method Auto ~
-9 SEQT VM Timer (sec) On Demand S
Prefix | |
Mational Prefix | |
International Prefix | |
Country Code | | Redirect and Transfer
-2 Control Unit (| Name Priority Systern Default ~ Incoming Supervised REFER uig v
if ?:rn(sgi)on @ Description | | Outgoing Supervised REFER Auto ~
‘ Nollser Send 302 Moved Temporarily O
::}:: sgg? E;g Outgoing Blind REFER O .
----- §r 2352 H323-| < >
----- - 25555IPS,
----- §r 2556 5IPS. g
----- $r 2557 51p i
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Select the Transport tab and enter the following information.
e The ITSP Proxy Address is set to the internal interface of Avaya SBCE.
e Layer 4 Protocol is set to TLS.
e Send Port is set to the port number of IP Office, 5061.
e Use Network Topology Info parameter is set to LAN 2. This associates the SIP Line with
the parameters in the System - LAN2 - Network Topology tab.
e Other parameters retain default values in the screen below.
e Click OK.

Configuration |2§" SIP Line - Line 2* g - X v <>

- & BOOTP (10)
~t# Operator (3)
“#527 Solution
+: User(31)
+-ig§ Group(1)
+-@% Short Code(45)
----- = Directory(0)
£ Time Profile(0)

-

----- B Account Code(D)

SIP Line Transport SIP URI WolP  SIP Credentials SIP Advanced Engineering

ITSP Proxy Address [10.10.97.176

Metwork Configuration

Layer 4 Protocol TLS ~ Send Port 3061

A ([4]r

Use Network Topology Info | LAN 2 ~ 5061

+-§ig User Rights(9)
@ Location(0) Explicit DNS Server(s) 0 0 0 0 0 0 0 0
-5 SEQT VM
-+ System (1)
= SEQT VM

Calls Route via Registrar

Separate Registrar |

aK Cancel Help

A SIP URI entry Channel 1 is created to match incoming numbers that IP Office will accept on this
line. Select the SIP URI tab, click Add button and then New Channel area will appear at the bottom
of the pane. To edit an existing entry, click an entry in the list at the top, and click the Edit... button.
In the example screen below, a previously configured entry is edited. For the compliance test, a
single SIP URI entry was created that matched any DID number assigned to an IP Office user. The
entry was created with the parameters shown below:

e Set Local URI, Contact and Display Name to Use Internal Data. This setting allows calls
on this line which SIP URI matches the number set in the SIP tab of any User as shown in
Section 5.6.

Set Identity to None and Header to P Asserted ID for Identity.

Set Sent Caller ID to Diversion Header for Forward and Twinning.

Set Diversion Header to None.

Associate this line with an incoming line group in the Incoming Group field. This line group

number will be used in defining incoming call routes for this line. Similarly, associate the

line to an outgoing line group using the Outgoing Group field. For the compliance test, a

new incoming and outgoing group 2 was defined that only contains this line (line 2).

e Set Max Calls per Channel to the number of simultaneous SIP calls that are allowed using
this SIP URI pattern.

e Other parameters retain default values and or set according customer requirements.

e Click OK.

QT; Reviewed:
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SIP Entry Channel 1 is shown below.

Configuration | = SIP Line - Line 2 IR AR

a BOOTP (10) SIP Line Transport SIP URI VoIP  SIP Credentials SIP Advanced Engineering
¢ Operator (3)
[=-%28 Solution URl Groups Local URI Contact Display Mame |dentity Header Originator Number Send Caller ID Din Add... ~

& User31) <Internal> <Internal> <Internal> MNone  PAI Diversion

!ﬂ Group(1) Remove
-@% Short Code(45)

----- @5 Directory(0)
£ Time Profile(0)
----- #m Account Code(0)
i#-fiy User Rights()
----- &5 Location(D)
E-527 SEQT VM
? Systern (1) -
| Lmy SEQTVM Edit URI QK
£ Line (6) Local URI |Use Internal Data V|

..... g, 1 Cancel
..... "y, 2 Contact |Use Internal Data V|

el
(R B}

Edit...

..... y, 4 Display Mame |Use|nterna|Data v|

""" 0 3 Identity

&< Control Unit (8) Identity [None v
(-4 Extension (7)
E-d User () Header P Asserted ID v

; NoUser . L
..... §~ 2550 H323-25¢ Forwarding And Twinning
----- & 2551 H323-25¢ Originater
----- g~ 2552 H323-25¢ Nurmber
----- & 2555 SIPS-255¢
..... t 2556 SIPS-255¢ Send Caller ID Tromsem [F=a »
----- 2357 5IP5-2550
----- § 2558 5IPS-255¢
----- ﬂ Group (0)

8% Shert Code (51) o
..... @ Service (0) Diversicn Header |N0ne w
E]---@ Inceming Call Rou
----- @ Directory (0]

£ Time Profile (0) Incoming Group

[o-Jill IP Route (1) he
----- B Account Code (0)
----- :*. License (31) Help

Registration 0: <Mene> ~

Select the VoI P tab to set the VVoice over Internet Protocol parameters of the SIP line. Set the
parameters as shown below:
e The Codec Selection can be selected by choosing Custom from the pull-down menu,
allowing an explicit ordered list of codecs to be specified.

e Selecting G.711 ALAW and G.729 codec supported by the Liechtenstein SIP Trunking
service, in the Session Description Protocol (SDP) offer.

e Set Fax Transport Support to G.711 from the pull-down.

e Set the DTMF Support field to RFC2833/RFC4733 from the pull-down menu. This directs
IP Office to send DTMF tones using RTP events messages as defined in RFC2833.

e Check the Re-invite Supported box.

e Check the PRACK/100rel Supported box.

e Media Security is set to Same as System (Preferred) and check the Same As System

checkbox.
e Default values may be used for all other parameters.
e Click OK.
QT; Reviewed: Solution & Interoperability Test Lab Application Notes 16 of 56
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Configuration

i= SIP Line - Line 2 =R IR A AN

gt

=& BOOTP (10)

Operator (3)

=38 Solution
+-§  User(31)
+-5§ Group(1)

SIP Line Transport SIP URI VelP  SIP Credentials SIP Advanced Engineering
[ Lecal Held Music

Re-invite Supported

+-@% Short Code(45) Codec Selection Custom > [ Codec Lockdown
- Directory(0)
£2) Time Prefile(0) Unused Selected [ Allow Direct Media Path
G.717 ULAW 84K G717 ALAW 64K
b ﬁ;:?;ir;thfig;(m 6722 62K see 6.729() 8K CS-ACELP Force direct media with phone

-]

+-@M Short Code (3
B Service (0)
-4 Incoming Call

+-Jfll IP Route (1)

L% Authorization
433 |PO SP EXP

<2 Control Unit (
-4y Extension (7)

PRACK/100rel Supported

Fax Transport Suppert | G.711

DTMF Support RFC2833/RFC4733

User (8)

----- S Nolser

Media Security Same as Systemn (Preferred)

Advanced Media Security Options Same As System

RTP

RTCP
RTP
RTCP
== Directory (0)
£ Time Profile (1

#m Account Code
% License (31)

#-§i5 User Rights (9 TP A
- ARS (1) SRTP AES Ol
&5 Location (0) SRTP_AES_CM W

Help

5.5. Short Code

Define a short code to route outbound traffic to the SIP line. To create a short code, select Short
Code in the left Navigation pane, then right-click in the Group Pane and select New. On the Short
Code tab in the Details pane, configure the parameters for the new short code to be created. The
screen below shows the details of the previously administered “6N;” short code used in the test

configuration.

e Inthe Code field, enter the dial string which will trigger this short code, followed by a semi-
colon. In this case, 6N; this short code will be invoked when the user dials 6 followed by any
number.

e Set Feature to Dial. This is the action that the short code will perform.

e Set Telephone Number to the value shown in the capture bellow. This field is used to
construct the Request URI and To headers in the outgoing SIP INVITE message. The value
N represents the number dialed by the user. The host part following the “@” is the domain of
the service provider network.

e Set the Line Group Id to the outgoing line group number defined on the SIP URI tab on the
SIP Line in Section 5.4. This short code will use this line group when placing the outbound
call.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 17 of 56
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e Others parameters are at default values.

e Click OK.
Configuration | Short Code i= 6N;: Dial ef - Xiv <=
R pooTp (10) Code Telephone Number 2 Short Code
{# Operator (3) /51
=) Solution x5 Code |5N: |
----- § Useran) o
..... 2% Group(1) X537 NE N Feature Dial ~
----- 8% Short Code(45) 935 . —
..... 2= Directory(0) BX5TNE N Telephone Number |N @t100000d.convoip.li |
£ Time Profile(D) PRBENE N Line Group ID |;;_ v|
----- L] Accou.nt Code(D) BCTNE N
""" §i4 User Rights(9) BUTIMNE N Locale ~
x99, "edit_messages" Force Account Code O
26N, IO onoihi Force Authorization Code []
TN
& Edons, BXEN;
4 ension (7) oxoN N
4 User(®)
5% Group (0 OXFNEOD 00 v e
8% Short Code (51) < >

For incoming calls from mobility extension to FNE (Feature Name/Number Extension) hosted by IP
Office to provide dial tone functionality, Short Code FNEOO was created. The FNEQOO was
configured with the following parameters.

¢ Inthe Code field, enter the FNE feature code as FNEQO for dial tone.

e Setthe Feature field to FNE Service.
e Set the Telephone Number field to 00.
e Setthe Line Group ID field to 0.
e Retain default values for other fields.
e Click OK.
Configuration | Short Code = FNEOO: FNE Service £ - Xlv|<]|>
BOOTP (10) Code Telephone Number 1| Short Code
Operator (3) x*51
=7 Solution - Code FMEQD
----- § Useran) “*52* . | |
..... a Group(1) BRF53 N N Feature FME Service ~
----- 8 Short Code(43) 9235
..... @ Directory(0) BX5TNE N Telephone Mumber |DD |
£ Time Profile(0) REETNE N .
----- #m Account Code(0) OXTONE N Line Group 1D |D V|
-3 User Rights(9) . o
""" & Location(0) BeTINE N ) Locale
- SEQT VM B-g9; "edit_messages” Force Account Code O
) System (1) BXEN; N"@t100000d.convoip.li” Force Authorization Code [
{ Line (8) ] TN N"@avayalab.com”
~“= Control Unit (8) o%EN;  N'@t100000d.convoip.li”
-4y Extension (7) BxaN N
& User(®) n
% Group (O FNEOD 00 v Help
-@% Short Code (51) g 2
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5.6. User

Configure the SIP parameters for each user that will be placing and receiving calls via the SIP line
defined in Section 5.4. To configure these settings, first select User in the left Navigation pane, then
select the name of the user to be modified in the center Group pane. In the example below, the name
of the user is “H323-2550". Select the SIP tab in the Details pane.

The values entered for the SIP Name and Contact fields are used as the user part of the SIP URI in
the From header for outgoing SIP trunk calls. They also allow matching of the SIP URI for incoming
calls without having to enter this number as an explicit SIP URI for the SIP line (Section 5.4). The
example below shows the settings for user H323-2550.

e The SIP Name and Contact are set to one of the DID numbers assigned to the enterprise
from service provider.

e The SIP Display Name (Alias) parameter can optionally be configured with a descriptive
name.

e If all calls involving this user and a SIP Line should be considered private, then the
Anonymous box may be checked to withhold the user’s information from the network.

e Click OK.

Configuration | User = H323-2550: 2550 e - X v <> &
R BOOTP (10) MName Extension

“ Operator (3) frH323-2550 2350
%/ Solution

User Voicemnail DND Short Codes  Source Numbers  Telephony Forwarding Dial In - Voice Recording

Personal Directory  Web Self-Administration

§rH323-2551 2551 - : — -
""" § User31) Button Programming Menu Programming Mobility Group Membership  Announcements  5IP
..... 2% Group(1) frH323-2552 2552 R
----- BX Short Code(45) fmNoUser SIP Name |DD42323?2?30 |
----- 22 Directory(0) §rsips-2555 2555
(I“\ Time Profile(D) a"S|PS-2556 2556 SIP Display Mame (Alias) |H323-2550 |
§rsips-2557 2557 Contact |[)[)42323?2?SD |

§sips-2558 2358

[] Anonymous

Hel
< > ==

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 19 of 56
SPOC 1/30/2017 ©2017 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



One of the H.323 IP Phones at the enterprise site uses the Mobile Twinning feature. The following
screen shows the Mobility tab for User H323-2550.

e The Mobility Features and Mobile Twinning boxes are checked.
e The Twinned Mobile Number field is configured with the number to dial to reach the
twinned mobile telephone, in this case 60016139675205.
e Check Mobile Call Control check-box.
e Other options can be set according to customer requirements.
e Click OK.
Configuration | User b H323-2550: 2550* g -8 X v <> &
’,‘ BOQTP (10) Name Bxten User Voicermnail DND Short Codes  Source Mumbers  Telephony Forwarding Dial In - Voice Recording
s Operator (3) §-H323-2550 2550 R
% Solution §rH323-2551 2551 Web Self-Administration
..... % g::;(sg] frr323-25%2 2592 Button Programming Menu Programming Mobility Group Membership Announcements  SIP Personal Directory R
..... X Short Code(45) frmNoUser [ Internal Twinning
----- @& Directory(0) aHSIPS-ESSE 2335 <None>
2 Time Profile(0) §rsips-2356 255
i Account Code(0) frsips-2557 2557 1
..... \l U R h 9
..... b L;:;tilogn(f[i;( ) rsips-2558 2558 Twin Bridge Appearances
=59 SEQTVM wvin Coverage Appearances
-5 System (1) Twin € 9= ApP
..... 7 Line (6) Twin Line Appearances
------ = Control Unit (8)
..... & Extension (7) Maobility Features
% g::LE;SJ(D) Mobile Twinning
----- 9 Short Code (51) Twinned Mobile Number - [g0016139675205 |
_____ @ Service (0) (including dial access code)
..... ) Incoming Call Rout Twinning Time Profile <None> i
----- == Directory (0) o
-7 Time Profile (0) Mobile Dial Delay (sec) |2 |
..... Kl 1P Route (1) Mohile Answer Guard (sec) |0 =

] ]

B Account Code (0]
& License (31)
§5 UserRights (9)

5 Location (0)
28 Authorization Code
IPQ 5P EXP

L4

>

[] Hunt group calls eligible for mebile twinning
[ Forwarded calls eligible for mobile twinning
[] Twin When Logged Out

one-X Mobile Client
Mobile Call Control
[] Mobile Callback

<

oK Lancel Help

5.7. Incoming Call Route

An incoming call route maps an inbound DID number on a specific line to an internal extension.
This procedure should be repeated for each DID number provided by the service provider. To create
an incoming call route, select Incoming Call Route in the left Navigation pane, then right-click in
the center Group pane and select New. On the Standard tab of the Details pane, enter the
parameters as shown below:
Set the Bearer Capacity to Any Voice.
Set the Line Group Id to the incoming line group of the SIP line defined in Section 5.4.
Set the Incoming Number to the incoming number on which this route should match.
Default values can be used for all other fields.

QT;
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An Incoming Call Route is shown below.

Configuration | Incoming CallRoute [= 2004232372780 el -E X v <>
~& BOOTP (10) Line Group 1D Incoming Number Standard  Vbice Recording  Destinations
4 Operator (3) @2 004232372786 A
= “j_'_’__i”'uut';'r‘e . 2 004232372781
_____ ﬂ Group(!) @2 004232372780 Bearer Capability Any Voice ~
..... 8% Short Code(d5) (-1} 004232372785 Line Group ID 2 v
Directory(0) @4 004232372783
Time Profile(0) @19 £122600000 Incoming Mumber |DD42323?2?SD |
Account Code(D) 19 6122600771 .
..... a; User Rights(9) @ o Incoming Sub Address | |
_____ &8 Location(0) @19 6132601021 _
0= SEQT VM Incoming CLI | |
- S}rstem 0] Locale o
..... 47 Line (6)
----- <= Control Unit (8) Priority 1-Low w
----- & Extension (7)
----- I User (8) Tag | |
..... .ﬂ Group (0)
..... 8% Short Code (51) Hold Music Source System Source ~
----- B Service (0) ) )
_____ @ Incoming Call Route (8) Ring Tone Override |N0ne v| v
----- @5 Directory (0)
f.i! Time Profile (0) Help
----- Bl |P Route (11 < >

On the Destinations tab, select the destination extension from the pull-down menu of the
Destination field. In this example, incoming calls to 004232372780 on line 2 are routed to extension
2550. Click OK.

Configuration | Incoming Call Route i= 2004232372780 cf - Xlv|<]>
S SEQ;'\u;M o Line Group ID Incoming Mumber Standard Voice Recording  Destinations
= aystem ?: 004232372786 - - — -
T‘. I&IE:t(r:)l @ @2 0232372781 TimeProfile Destination Fallback Extension
_____ © bamnon 2 Ty TR RETATET »  |Default Value 2550 H323-2550 v v
..... i User®) : 004232372785
""" ﬁ Group (0) @4 004232372783
""" short Code (51) @1 §132600900
g Isne:::neirfD]Call Route (8) @19 6132600771
..... - Di,ector}? ) @19 6132601021
{7 Time Profile (0) < > Help
5.8. Save Configuration
Navigate to File = Save Configuration in the menu bar at the top of the screen to save the
configuration performed in the preceding sections.
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5.9. Avaya IP Office TLS Certificate Management

This section provides a procedure on how to download the IP Office certificate which is being
installed on Avaya SBCE for the communication between Avaya system’s components using TLS
connectivity.

To download the IP Office certificate, launch a web browser and log in Avaya IP Office Web
Management as shown below.

N Avaya IP Office Web Mar X
L C' | @ https://10.10.97.61:7070/WebManagement/WebManagement.html| TN =

Avaya IP Office Web Manager

User Name Administrator
Password = eesssecsssccsse
Select Language English v

Offline Mode i ]

© 2016 Avaya Inc. All Rights Reserved.

On the Solution page, click on drop-down menu on the right and select Platform View as shown.

AVAYA

Solution  Call Management  System Seitings = Security Manager  Applications
Solution
T DBJECTS
View All (2) Actions ~ Configure ~
@ SEQTVM 135.10.97.61 = ~
. . Dashboard
Online (2) @ PO SPEXP 135.10.97.229 ashboar o
Offline (0) Platform View
Backup
. Restore
Servers (1)
Expansions (1) On-boarding
Application Servers (0) Launch SSA

Service Commands
Initial Configuration

Download Configuration

View Upgrade Report
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On the Platform page, click on Settings and scroll down to Certificates section. At CA Certificate
section, click on the Download (PEM-encoded) button to obtain the IP Office CA certificate.

AVAYA
@ Solution = Call Management  System Settings = Security Manager  Applications ‘ ?
Platform - | 10.10.97.61 | &
Settings
I System
Certificates CA Certificate -
Create new '® Renew existing Import Export

Fegenerate Download (PEM-encoded) Download (DER-encoded)
Identity Certificates

#| Renew automatically
Warning: The certificate will be automatically regenerated and replaced for all applications, when a change that causes
itto expire (such as network or LAN change) takes place. This will cause all applications to restart, and you will be
redirected to the login page.

Create certificate for a difierent machine

Subject Name: 000C20EBBESE
Subject Alternative Name(s): pNS:000C29E8BESE, IP10.10.97 61, IP:192.168.43.1
Duration (days): 2555
Public Key Algorithm: RSA-2048 v
Secure Hash Algorithm: SHA-256 v

Regenerate and Apply Download (PEM-encoded) Download (DER-encoded)

A
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6. Configure the Avaya Session Border Controller for

Enterprise

This section covers the configuration of the Avaya SBCE. It is assumed that the software has already
been installed. For additional information on these configuration tasks, see Section 10.

The compliance testing comprised the configuration for two major components, Trunk Server for the
service provider and Call Server for the enterprise. Each component consists of a set of Global
Profiles, Domain Policies and Device Specific Settings. The configuration is defined in the Avaya
SBCE web user interface as described in the following sections.

Trunk Server configuration elements for the service provider - Liechtenstein:
e Global Profiles:
o URI Groups

Routing
Topology Hiding
Server Interworking
Signaling Manipulation

o Server Configuration
e Domain Policies:

o Application Rules
Media Rules
Signaling Rules
Endpoint Policy Group
Session Policy
e TLS Management

o Certificates

o Client Profiles

o Server Profiles
e Device Specific Settings:

o Network Management
Media Interface
Signaling Interface
End Point Flows - Server Flows
Session Flows

@)
©)
@)
©)

O O O O

o O O O

Call Server configuration elements for the enterprise - IP Office:
e Global Profiles:
o URI Groups
o Routing
o Topology Hiding
o Server Interworking
o Server Configuration
e Domain Policies:
o Application Rules
o Media Rules
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o Signaling Rules

o Endpoint Policy Group

o Session Policy
e TLS Management

o Certificates

o Client Profiles

o Server Profiles
e Device Specific Settings:

o Network Management
Media Interface
Signaling Interface
End Point Flows - Server Flows
Session Flows

o O O O

The naming convention in this entire section is using as follow:
e SPis stand for Service Provider, which is Liechtenstein in this case.
e EN is stand for Enterprise Network, which refers to Avaya IP Office.

6.1. Log into the Avaya Session Border Controller for Enterprise

Use a Web browser to access the Avaya SBCE Web interface, enter https://<ip-addr>/sbc in the
address field of the web browser, where <ip-addr> is the management IP address.

Enter the appropriate credentials then click Log In.

o v a o Log In
Username: ucsec

Password: [(TTIY YT YYYTTY ]
Log In
Session Border Controller WELCOME TO AVAYA SBC
fﬂr Enterprise Unauthorized access to this machine is prohibited. This system is for the

use authorized users only. Usage of thizs system may be monitored and
recorded by system personnel

Anyone using this system expressly consents to such monitoring and is
advized that if such montering revealz possible evidence of criminal
activity, system perzonnel may provide the evidence from such
monitoring to law enforcement officials.

@ 2011 - 2016 Avaya Inc. All rights reserved.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 25 of 56
SPOC 1/30/2017 ©2017 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71




The Dashboard main page will appear as shown below.

Dashboard

Administration

Dashboard

Backup/Restore
System Management
> Global Parameters

» TLS Management

» Device Specific Settings Build Date

License State
Aggregate Licensing Overages

Peak Licensing Overage Count
Last Logged in at

Failed Login Attempts

Alarms (past 24 hours)

MNone found.

Session Border Controller for Enterprise

* Giobal Profiles
* PPM Services System Time 12:57:07 Refrash
. . PM CST
» Domain Policies
Version 7.1.0.1-07-12090

Sun Dec 4 19:22:22
EST 2016

@ 0K
0
0

12/11/2016 10:21:54
CST

0

AVAYA

This system contains one or more Avaya demo certificates. These certificates have been

compromised and should not be used for any production traffic.

Installed Devices

EMS

mSBCE

Incidents (past 24 hours)
mSBCE : Heartbeat Successful, Server is UP

6.2. TLS Management

Transport Layer Security (TLS) is a standard protocol that is used extensively to provide a secure
channel by encrypting communications over IP networks. It enables clients to authenticate servers
or, optionally, servers to authenticate clients. The Avaya SBCE utilizes TLS primarily to facilitate

secure communications with remote users.

Avaya SBCE is preinstalled with several certificates and profiles that can be used to quickly set up

secure communication using TLS, which are listed in the Pre-installed Avaya Profiles and
Certificates section. IP Office, Avaya SBCE and the 96x1 IP Deskphones are shipped with a default
identity certificate to enable out-of-box support for TLS sessions. Do not use this default certificate
in a production/customer environment since this certificate is common across all instances of IP
Office, Avaya SBCE and the 96x1 IP Deskphones. Avaya SBCE supports the configuration of third-
party certificates and TLS settings. For optimum security, Avaya recommends using third-party CA
certificates for enhanced security.

Testing was done with default identity certificate. The procedure to obtain and install third party CA
certificates is outside the scope of these application notes.

In this compliance testing, TLS transport is used for the communication between IP Office and
Avaya SBCE. The following procedures show how to create the client and server profiles.
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6.2.1. Certificates

You can use the certificate management functionality that is built into the Avaya SBCE to control all
certificates used in TLS handshakes. You can access the Certificates screen from TLS Management
-> Certificates.

Ensure the preinstalled certificates are presented in the system as shown below.
e AvayaSBCCA.crt is Avaya SBCE Certificate Authority root certificate.
e root-ca.pem is the IP Office root certificate obtained from Section 5.9.

Session Border Controller for Enterprise AVAYA
Dashboard Certificates

Administration Install Generate CSR
Backup/Restore —

Systerm Management Certificates

> Global Parameters Installed Certificates

> Global Profiles

AvayaSBC.crt View Delete
» PPM Services )
) o SymantecClass3.pem View Delete
> Domain Policies
4 TLS Management Installed CA Certificates
Certificates AvayaSBCCA. crt View Delete
Client Profiles -
root-ca.pem View Delete
Server Profiles
> Device Specific Settings Installed Certificate Revocation Lists

No certificate revocation lists have been installed.

Installed Keys
AvayaSBC key Delete
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If the IP Office Certificate Authority certificate (root-ca.pem) is not present, the following procedure
will show how to install it here on Avaya SBCE.

IP Office CA certificate is obtained using procedure provided in Section 5.9. Then on Avaya SBCE,
navigate to TLS Management - Certificates. Click on Install button.
e Select CA Certificate.
e Provide a descriptive Name. In the example below, the Name field was left empty and
default name was used as root-ca.pem.
e Browse to the directory where the IP Office CA was previously saved and select it.
e Click Upload.

Install Certificate X

O Certificate
Type ® CA Cetificate
O Certificate Revocation List
Mame |
Owerwrite Existing O
Allow Weak Certificate/Key O]
Certificate File root-ca.pem

Upload

6.2.2. Client Profiles

This section describes the procedure to create client profile for Avaya SBCE to communicate with IP
Office via TLS signalling. This will be used in Section 6.3.3.2.

To create Client profile, navigate to TLS Management - Client Profiles, click Add.
e Enter descriptive name in Profile Name.
e Select AvayaSBC.crt from pull down menu of Certificate.
e For Peer Verification, select IP Office CA certificate which was installed in the above

section.
e Enter 1 as Verification Depth.
e Click Finish.
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Capture below illustrates a client profile being created on Avaya SBCE.

Edit Profile X

1 to have been compromised and should not be v

es cipher checking, Cipher Suite validation will

re invalid
our ent  invalid or incorrect
may cause catastrophic problems.

TLS Profile
Profile Name |A1.ra1,raSBCCIient—Q |
Certificate |A1.ra:.raSE!C.crt

Certificate Info

Peer Verification Required

root-ca.crt

Peer Certificate Authorities Cisco_phone_CA.crt

SymantecClass3.pem

Peer Certificate Revocation Lists

Werification Depth

Renegotiation Parameters

Renegotiation Time ICI seconds

Renegotiation Byte Count |EI

Handshake Options

Version TLS 1.2 TLS 1.1 TLS 1.0
Ciphers ® Defaut O FIPS O Custom
Value HIGH:!DH:!ADH:!MD5:!aMULL:leMULL: @STRENGTH

{(What's this)

Finish
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6.2.3. Server Profiles

This section describes the procedure to create server profile for Avaya SBCE to communicate with

IP Office via TLS signalling. This will be used in Section 6.5.3.

To create Server profile, navigate to TLS Management - Server Profiles, click Add.

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 30 of 56
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Enter descriptive name in Profile Name.
Select AvayaSBC.crt from pull down menu of Certificate.
Select None from pull down menu of Peer Verification.

Select Custom for Ciphers in Cipher Suit Options section. And Value ALL is specified in

the capture shown below.
Click Finish.

Edit Profile X

TLS Profile

Profile Name |A1.ra}raSEICSer1.rer |

Certificate |A\.ra1,raSBC.crt v|

Certificate Info

Peer Verification
AvayasSBCCA.crt ~
Pear Cerificate Authorities EI’ISIL]I'I- Universal Root Certification Authority.cer
SMGRCA.pem
Affiliated.crt W
Peer Certificate Revocation Lists
Verification Depth 0

Renegotiation Parameters

Renegotiation Time Cl seconds

Renegotiation Byte Count ||:|

Handshake Options

Version TLS 1.2 TLS 1.1 TLS 1.0
Ciphers 0 Default O FIPS @ Custom
VE'UE |J‘51|_|_

{Whats this?)

Finish




6.3. Global Profiles
Global Profiles allows for configuration of parameters across all Avaya SBCE appliances.

The naming convention in this entire section is using as follows:
e SP stands for Service Provider, which is Bell in this case.
e EN stands for Enterprise Network, which is referred to Avaya IP Office.

6.3.1. Uniform Resource Identifier (URI) Groups

URI Group feature allows user to create any number of logical URI groups that are comprised of
individual SIP subscribers located in that particular domain or group. These groups are used by the
various domain policies to determine which actions (Allow, Block, or Apply Policy) should be used
for a given call flow.

For this configuration testing, “*” is used for all incoming and outgoing traffic.

6.3.2. Server Interworking Profile
Interworking Profile features are configured differently for Call Server and Trunk Server.

To create a Server Interworking profile, select Global Profiles = Server Interworking. Click on
the Add button.

In the compliance testing, two Server Interworking profiles were created for SP and EN respectively.
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6.3.2.1 Server Interworking Profile for SP
Profile SP-SI was defined to match the specification of SP. The General, URI Manipulation and

Advanced tabs are configured with the following parameters while the other tabs for Timers,
Privacy and Header Manipulations are kept as default.

General tab:

e Hold Support = NONE. The Avaya SBCE will not modify the hold/ resume signaling from
EN to SP.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from EN to SP.

e Refer Handling = No. The Avaya SBCE will not handle REFER. It will keep the REFER
message unchanged from EN to SP.

e T.38 Support = No. SP does not support T.38 fax in the compliance testing.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile SP-SI, General.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: SP-SI
Administration Add Rename Clone Delete
Backup/Restore
Inte ] Click here e scription.
System Management ;r.jfg‘;:;r ing Click here to add a description
> Global Parameters 252100 General | | Timers | | Privacy | | URI Manipulation | | Header Manipulation || Advanced |
4 Global Profiles
Server Interworking OCS-Edge-S... Hold Support NONE
Media Forking cisco-com 180 Handling Maone
Routing 181 Handling Mone
. . cups
Server Configuration . 182 Handiing None
Topology Hiding Sipera-Halo
i i i i 183 Handling MNone
Signaling Manipulation OCS-FrontEn...
URI Groups o Refer Handling Mo
SNMP Traps URI Group Maone
Time of Day Rules MTSAllstream Send Hold Mo
EN-SI
FGDN Groups Delayed Offer Mo
Reverse Proxy Policy RC
; 3xx Handli M
* PPM Services ThinkTel ERSITELE °
> Domain Policies ke Diversion Header Support Mo
> TLS Management 5pP-31 Delayed SDP Handling No
> Device Specific Settings SP4 Re-Invite Handling No
IPO_42 Prack Handling Mo
IPO_14 Allow 18X SDP Mo
T.38 Support Mo
URI Scheme SIP
Via Header Format RFC3261
Edit
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Advanced tab:

e Record Routes = Both Sides. The Avaya SBCE will send Record-Route header to both call
and trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows the Avaya SBCE to always use the SDP
received from EN for the media.

e DTMF Support = None. The Avaya SBCE will send original DTMF method from SP to

EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile SP-SI, Advanced.

Dashboard
Administration
Backup/Restore
System Management

Session Border Controller for Enterprise

Interworking Profiles: SP-SI
Add

Click here

Interworking

Profiles

AVAYA

Rename Clone Delete

to add a description.

> Global Parameters EN-SI General || Timers | | Privacy | | URI Manipulation || Header Manipulation || Advanced L
4 Global Profiles
Domain DoS SP_s| Record Routes Both Sides
Server Interworking Include End Paint IP for Context Lookup  No
Media Forking Extensions Avaya
Routing Diversion Manipulation Nao
Server Configuration
o Has Remote SBC Yes
Topology Hiding
Signaling Manipulation Route Response on Via Port Mo
URI Groups Relay INVITE Replace for SIPREC Mo
SNMP Traps
Time of Day Rules
FGDN Groups DTMF Support None
> PPM Services Edit
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6.3.2.2 Server Interworking Profile for EN
Profile EN-SI was defined to match the specification of EN. The General and Advanced tabs are

configured with the following parameters while the other settings for Timers, Privacy, URI
Manipulation and Header Manipulation are kept as default.

General tab:

e Hold Support = NONE.

e 18X Handling = None. The Avaya SBCE will not handle 18X, it will keep the 18X
messages unchanged from SP to EN.

e Refer Handling = No. The Avaya SBCE will not handle REFER, it will keep the REFER
messages unchanged from SP to EN.

e T.38 Support = No. To match with SP profile.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, General.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: EN-SI
Administration Add Rename Clone Delete
Backup/Restore
Inte ki Click here scription.
System Management Fr?n;ed;\ln\;c:;r ing Click here to add a description
> Global Parameters 52100 General || Timers | | Privacy | | URI Manipulation || Header Manipulation || Advanced |
] . General
Domain DoS avaya-u e
Server Interworking OCS-Edge-5... Hold Support NONE
Media Forking cisco-com 180 Handling MNaone
Routing 181 Handling Mone
S Configuration cues
erver Lonfg _ 182 Handling None
Topology Hiding Sipera-Halo
. ] . . 183 Handling Mone
Signaling Manipulation 0OCS-FrontEn._.
URI Groups o Refer Handling Mo
SMNMP Traps URI Group None
Time of Day Rules MTSAllstream Send Hold Mo
EN-SI
FGDN Groups Delayed Offer Mo
Reverse Proxy Policy RC
] 3w Handli M
* PPM Services ) >ocnianding °
> Domain Policies ThinkTel Diversion Header Support Mo
> TLS Management SP-sl Delayed SDP Handling No
> Device Specific Settings SP4 Re-Imite Handling Mo
IPO_42 Prack Handling Mo
IPO_14 Allow 18X SDP Mo
T.38 Support Mo
URI Scheme SIP
Via Header Format RFC3261
Edit
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Advanced tab:

e Record Routes = Both Sides. The Avaya SBCE will send Record-Route header to both call
and trunk servers.

e Include End Point IP for Context Lookup = No.

e Extensions = Avaya.

e Has Remote SBC = Yes. This setting allows the Avaya SBCE to always use the SDP
received from EN for the media.

e DTMF Support = None. The Avaya SBCE will send original DTMF method from SP to
EN.

e Others are left as default values.

The screenshots below illustrate the Server Interworking profile EN-SI, Advanced.

Session Border Controller for Enterprise AVAYA
Dashboard Interworking Profiles: EN-SI
Administration Add Rename Clone Delete
Backup/Restore
Interworki Click here to scription.

System Management Sr;%\;:;r ing Click here to add a description
» Global Parameters EN.SI General || Timers || Privacy | | URI Manipulation | | Header Manipulation | | Advanced L
[ Global Profiles

Domain DoS Sp.g)| Record Routes Both Sides

Server Interworking Include End Point IP for Context Lookup  No

Media Forking Extensions Avaya

Routing Diversion Manipulation Nao

Server Configuration

. Has Remote SBC Yes

Topology Hiding

Signaling Manipulation Route Response on Via Port Mo

URI Groups Relay INVITE Replace for SIPREC Mo

SNMP Traps

Time of Day Rules OTME

FGDN Groups DTMF Support None
> PPM Services Edit

6.3.3. Server Configuration

Server Configuration screen contains four tabs: General, Authentication, Heartbeat, and
Advanced. These tabs are used to configure and manage various SIP Call Server specific parameters
such as TCP and UDP port assignments, heartbeat signaling parameters, DoS security statistics and
trusted domains.

To create a Server Configuration entry, select Global Profiles > Server Configuration. Click Add
button. In the compliance testing, two separate Server Configurations were created, server entry SP-
SC for SP and server entry EN-SC for EN.

6.3.3.1 Server Configuration for SP

Server Configuration named SP-SC was created for the SP. It will be discussed in detail below.
General and Advanced tabs are provisioned for SP on the SIP trunk for every outbound call from
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enterprise to PSTN. Authentication is enabled to allow Avaya SBCE to send out authentication to
SP. Heartbeat tab is enabled to allow the Avaya SBCE to forward the OPTIONS heartbeat from EN
to SP to query the status of the SIP trunk.

General tab: Click Add button and enter following information.
e Enter Profile Name SP-SC and click Next button (not shown).
e Set Server Type for SP as Trunk Server.
e Enter provided IP Address/FQDN of SP. Transport UDP and listening on port 5083.
e Click Next, Next and Finish (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration Add Rename Clone Delete
P i
Global Profiles General | | Authentication | | Heartbeat | | Advanced

Domain DoS

Server Interworking EN-SC Server Type Trunk Server

Media Forking SP-5C

IP Address / FQDN Transport

Routing

Server Configuration 192.168.238.246 5083 UDP

Topology Hiding Edit

Authentication tab: Click Edit button and enter following information.
Check the Enable Authentication checkbox.

e Enter the User Name provided by service provider.

e Enter the Password and Confirm Password provided by service provider (not shown).

e Click Finish.
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC

Administration
< (Global Profiles

) Server Profiles General | | Authentication | | Heartbeat | | Advanced
Domain DoS

Add Rename Clone Delete

Server Interworking EN-SC Enable Authentication
Media Forkin :
) d SP-5¢ User Name LITLITestAvayaFL01
Routing
Server Configuration Realm
Topology Hiding Edit
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Heartbeat tab: Click Edit button and enter following information.

e Check the Enable Heartbeat checkbox.

e Select REGISTER from dropdown list for Method.

e Enter 30 seconds for Frequency.

e Enter user-name@itsp-domain provided by service provider for From URI and To URI.

e Click Finish.
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration Add Rename Clone Delete
Backup/Restore

General || Authentication | | Heartbeat | | Advanced
Systerm Management
» Global Parameters EN-SC Enable Heartheat
4 Global Profiles SP_SC
) Method REGISTER

Domain DoS

Server Interworking Frequency 30 seconds

Media Forking From URI LITLITestAvayaFL01@t100000d.convoip.li

Routing To URI LITLITestAvayaFL01@t100000d.convoip.li

Server Configuration

Topology Hiding Edit

Advanced tab: Click Edit button and enter following information.

e Interworking Profile drop down list, select SP-SI as defined in Section 6.3.2.

e The other settings are kept as default. Click Finish (not shown).
Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: SP-SC
Administration Add Rename Clone Delete
Backup/Restore

General | | Authentication || Heartbeat | | Advanced

Systerm Management
* Global Parameters EN-SC Enable DoS Protection Il
4 (Global Profiles SP-SC

Domain DoS Enable Grooming |

Server Interworking Interworking Profile SP-8l

Media Forking Signaling Manipulation Script Mone

Routing Securable O

Server Configuration

Topology Hiding Enable FGDN O

Signaling Manipulation =

1121 Sronime
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6.3.3.2 Server Configuration for EN

Server Configuration named EN-SC created for EN is discussed in detail below. General and
Advanced tabs are provisioned but no configuration is done for Authentication tab. The Heartbeat
tab is kept as disabled as default to allow the Avaya SBCE to forward the OPTIONS heartbeat from
SP to EN to query the status of the SIP trunk.

General tab: Click Add button then specifying the following.

Server Type for EN as Call Server and click Next button (not shown).

IP Address/FQDN is IP Office WAN port IP address.

Transport, between the Avaya SBCE and IP Office was TLS, and Port 5061.
TLS Client Profile is the profile created in Section 6.2.2.

Click Next, Next and Finish (not shown).

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
Administration Add Rename Clone Delete
Backup/Restore
General | | Authentication | | Heartbeat | | Advanced
System Management
* Global Parameters SP-sC Server Type Call Sarver
4 Global Profiles EN-SC

TLS Client Profile AvayaSBCClient-Q

Domain DoS
IP Address / FQDN

Transport

Server Interworking
Media Forking
Routing

10.10.97.61 5061 TLS

Edit
Server Configuration

Advanced tab: Click Edit button then enter the following information.
e Interworking Profile drop down list select EN-SI as defined in Section Error! Reference
source not found..
e The other settings are kept as default.

Session Border Controller for Enterprise AVAYA
Dashboard Server Configuration: EN-SC
Administration Add Rename Clone Delete
Backup/Restaore
General | | Authentication | | Heartbeat | | Advanced
System Management
* Global Parameters SP-sC ;
Enable DoS Protection O
4 Global Profiles EN-SC
Domain DoS Enable Grooming |
Server Interworking Interworking Profile EN-SI
Media Forking Signaling Manipulation Script None
Routi
outing Securable O
Server Configuration
Topology Hiding Enable FGDN O
Signaling Manipulation —
URI Groups
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6.3.4. Routing Profiles

Routing profiles define a specific set of packet routing criteria that are used in conjunction with other
types of domain policies to identify a particular call flow and thereby ascertain which security
features will be applied to those packets. Parameters defined by Routing profiles include packet
transport settings, name server addresses and resolution methods, next hop routing information and
packet transport types.

To create a Routing profile, select Global Profiles & Routing then click on the Add button.

In the compliance testing, routing profile SP-RP was created to be used in conjunction with the
Server Flow (see Section 6.5.4) defined for EN. This entry is to route outgoing calls from the
enterprise to SP.

In the opposite direction, Routing profile EN-RP was created to be used in conjunction with the
Server Flow (see Section 6.5.4) defined for SP. This entry is to route incoming calls from SP to the
EN.

6.3.4.1 Routing Profile for SP

The screenshot below illustrates the routing profile from Avaya SBCE to the SP network, Global
Profiles & Routing: SP-RP. As shown in Figure 1, the SP SIP trunk is connected with
transportation protocol UDP. If there is a match in the “To” or “Request URI” headers with the URI
Group “*” defined in Section Error! Reference source not found., the call will be routed to the Next
Hop Address which is the IP address of SP SIP trunk.

Session Border Controller for Enterprise AVAYA
Dashboard Routing Profiles: SP-RP
Administration Add Rename Clone Delete
Backup/Restore ;
System Management Click here to add a description.
> Global Parameters SP-RP Routing Profile
4 Global Profiles
) Update Priority Add
Domain DoS

Server Interworking Priority URI Time of  Load Next Hop

Media Forking

Routing . default  Priority 192.168.238.246  UDP  Edit Delete

Server Configuration

Transport

Group Day Balancing Address
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6.3.4.2 Routing Profile for EN

The Routing Profile for SP to EN, EN-RP was defined to route call where the “To” header matches
the URI Group “*” defined in Section Error! Reference source not found. to Next Hop Address
which is the IP address of IP Office WAN port as a destination. As shown in Figure 1, the SIP trunk
between EN and the Avaya SBCE is connected with transportation protocol TLS.

Session Border Controller for Enterprise AVAYA

Dashboard Routing Profiles: EN-RP

Administration Add Rename Clone Delete

Backup/Restore
System Management Routing Profiles Click here to add a description.
» (Global Parameters Bt Routing Profile
4 Global Profiles To_IPO
. Update Priority Add
Domain DoS SP-RP
’ o URI Time of Load Next Ho|
Server Interworkin ) P s
) ] g E— Group Day Balancing Address L2 ELL
Media Forking
Routing . default  Priority 10.10.97.61 TS Edit Delete

6.3.5. Topology Hiding

Topology Hiding is a security feature of the Avaya SBCE which allows changing certain key SIP
message parameters to ‘hide’ or ‘mask’ how the enterprise network may appear to an unauthorized
or malicious user.

To create a Topology Hiding profile, select Global Profiles & Topology Hiding then click on the
Add Profile (not shown).

In the compliance testing, two Topology Hiding profiles were created: SP-TH and EN-TH.

6.3.5.1 Topology Hiding Profile for SP
Topology Hiding profile SP-TH was defined for outgoing calls to SP as shown in the capture below.
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The screenshots below illustrate the Topology Hiding profile SP-TH.

Dashboard
Administration
Backup/Restare
System Management
> Global Parameters
4 Global Profiles
Domain DoS
Server Interworking
Media Forking
Routing
Server Configuration
Topology Hiding
Signaling Manipulation
URI Groups
SNMP Traps
Time of Day Rules
FGDN Groups

Reverse Proxv Policv

Topology Hiding Profiles: SP-TH

default

EN-TH
SP.-TH

Add

Topology Hiding

Session Border Controller for Enterprise

Click here to add a description.

AVAYA

Rename Clone Delete

Header

Via
Referred-By
Request-Line
Refer-To

SDP
Record-Route
To

From

Criteria

IP/Domain
|P/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain
IP/Domain

IP/Domain

Replace Action

Auto
Auto
COverwrite
Auto
Auto
Auto
Owerwrite

Ovenwrite

Edit

Overwrite Value

t100000d._convoip.li

t100000d_convoip.li

t100000d.convaip.li

6.3.5.2 Topology Hiding Profile for EN
Topology Hiding profile EN-TH was defined for incoming calls to IP Office as shown in the capture

below.

Dashboard
dministration
Backup/Restore
System Management
> Global Parameters

Topology Hiding Profiles: EN-TH

Topology Hiding

Session Border Controller for Enterprise

Click here to add a description.

AVAYA

Rename Clone Delete

default
[ Global Profiles
eade Criteriz leplace Actio Overwrite Value
Domain DoS EN-TH Header Criteria Replace Action Overwrite Value
Server Interworking SP-TH Via IP/Domain Auto -
Media Forking Referred-By IP/Domain Auto -
Routing Refer-To IP/Domain Auto -
Server Configuration Request-Line IP/Domain Overwrite £100000d.convaip. |
Topology Hiding
. i . . SDP IP/Domain Auto —
Signaling Manipulation
URI Groups Record-Route IP/Domain Auto -
SNMP Traps To IP/Damain Owerwrite t100000d.convoip.li
Time of Day Rules From IP/Damain Overwrite t100000d_convoip.li
FGDN Groups
Reverse Proxv Policy I
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6.4. Domain Policies

The Domain Policies feature configures various rule sets (policies) to control unified
communications based upon criteria of communication sessions originating from or terminating at
the enterprise. These criteria can be used to trigger policies which, in turn, activate various security
features of the Avaya SBCE security device to aggregate, monitor, control and normalize call flow.
There are default policies available for use, or a custom domain policy can be created.

6.4.1. Signaling Rules

Signaling Rules define the action to be taken (Allow, Block, Block with Response, etc.) for each
type of SIP-specific signaling request and response message. When SIP signaling packets are
received by the Avaya SBCE, they are parsed and “pattern-matched” against the particular signaling
criteria defined by these rules. Packets matching the criteria defined by the Signaling Rules are
tagged for further policy matching.

To clone a signaling rule, navigate to Domain Policies = Signaling Rules, select the default rule
then click on the Clone Rule button (not shown).

In the compliance testing, two Signaling Rules were created for the SP and EN.

6.4.1.1 Signaling Rule for SP
Clone the Signaling Rule default with a descriptive name (e.g., SP-SR) and click on the Finish
button (not shown). Verify that General settings of SP-SR with Inbound and Outbound Request

are set to Allow, and Enable Content-Type Checks is enabled with Action and Multipart-Action
are set to Allow (not shown).

On the Signaling QoS tab, enter the following information.
e Select the correct Quality of Service (QoS).
e The Avaya SBCE can be configured to mark the Differentiated Services Code Point (DSCP)
in the IP packet header with specific values to support Quality of Services policies for
signaling.

The following screen shows the QoS value used for the compliance testing.

Session Border Controller for Enterprise AVAYA
Dashboard Signaling Rules: SP-SR
pAdministration | Add | Filter By Device... - I Rename H Clone H Delete I
Backup/Restore
Systemn Management Click here to add a description.
» Global Parameters SP-SR me]ﬂ | Requests | | Responses | | Request Headers | | Response Headers | | Signaling QoS |
[« Domain Palicies ucip

Application Rules Signaling QoS

Border Rules

Media Rules QoS Type Dsce

Security Rules DSCP EF

Slgnall.ng Ru.les I == I
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6.4.1.2 Signaling Rule for EN

Clone the Signaling Rule default with a descriptive name (e.g., EN-SR for EN) and click on the
Finish button (not shown). Verify that General settings of EN-SR with Inbound and Outbound
Request are set to Allow, and Enable Content-Type Checks is enabled with Action and
Multipart-Action are set to Allow (not shown). Similarly the Signaling QoS rules are set as shown
in capture below.

Session Border Controller for Enterprise AVAYA

Dashboard Signaling Rules: EN-SR

Aidministration

Add Filter By Device... - [ Rename ” Clone ][ Delete ]

Packup/Restore

Sy stem Management Signaling Rules Click here to add a description.
W L] o] [Rops Rt oo tssen] S 5
¥ Domain Policies SP-SR ucip

Application Rules Signaling QoS

Border Rules

Media Rules QoS Type DSCP

Security Rules DSCP EF

Signaling Rul

e m
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6.4.2. Application Rules

Application Rules define which type of SIP based Unified Communications (UC) applications the
Avaya SBCE security device will protect: voice, video, and/or Instant Messaging (IM). In addition,
user can determine the maximum number of concurrent voice and video sessions the network will
process in order to prevent resource exhaustion.

6.4.2.1 Application Rule for SP

Clone the Application Rule default with a descriptive name (e.g., SP-AR for service provider) and
click the Edit button to change value of Maximum Concurrent Sessions and Maximum Session
Per Endpoint to 500 respectively as shown and then click the Finish button (not shown). Others are
left as default.

Session Border Controller for Enterprise AVAYA

Pashboard Application Rules: SP-AR

Aidministration

Add Filter By Device... - Rename ][ Clone ” Delete ]

Packup/Restore

Application

Click here to escription.
System Management lick here to add a description

Rules

- Global Parameters icati
ool Pro SP.AR Application Rule
- Global Profiles
. _ . . Maximum Concurrent  Maximum Sessions
- PPM Services RW-AR Application Type = Sessions ' Per Endpoint o
¥ Domain Policies EN-AR
o Audio 500 500
Application Rules
Border Rules Video O O

6.4.2.2 Application Rule for EN

Similarly, clone the Application Rule default with a descriptive name (e.g., EN-AR for IP Office)
and click the Edit button to change value of Maximum Concurrent Sessions and Maximum
Session Per Endpoint to 500 respectively as shown and then click the Finish button (not shown).
Others are left as default.

Session Border Controller for Enterprise AVAYA

Dashboard Application Rules: EN-AR

Administration

Add Filter By Device... - Rename ][ Clone ” Delete ]

Backup/Restore

Application

Click here to add a description.

System Management Rules

> Global Parameters I Application Rule
> Global Profiles
; RW-AR S = Maximum Concurrent  Maximum Sessions
> PPM Services Application Type In Out Sessions Per Endpoint
4 D in Polici EN-AR
orman Foleies Audio 500 500
Application Rules
Border Rules Video [
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6.4.3. Media Rules

Media rules can be used to define RTP media packet parameters, such as prioritizing encryption
techniques and packet encryption techniques. Together these media-related parameters define a strict
profile that is associated with other SIP-specific policies. You can also define how Avaya SBCE
must handle media packets that adhere to the set parameters.

6.4.3.1 Media Rule for SP

In this compliance testing, Secure Real-Time Transport Protocol (SRTP, media encryption) is not
supported by SP. Therefore, default-low-med rule is used for communication between Avaya SBCE
and SP.

6.4.3.2 Media Rule for EN

Secure Real-Time Transport Protocol (SRTP, media encryption) is used between Avaya SBCE and
IP Office. Therefore, it is necessary to create a media rule to apply to the internal interface of Avaya
SBCE, EN. Created EN-SRTP-MR rule is shown below.

Session Border Controller for Enterprise AVAYA

Dashboard Media Rules: EN-SRTP-MR

Administration

Add |Fi|ter By Device... v| Rename Clone Delete
Backup/Restore
Media Rules Click here escription.
System Management edia Rule lick here to add a description
> Global Parameters default-low-med Encryption | | Codec Prioritization | | Advanced | | QoS |
> Global Profiles EN-SRTP-MR
. Audio Encryption
> PPM Services bl
. - SETP_AES CM_128_HMAC_SHA1_32
4 Domain Policies Preferred Formats SRTP_AES_CM_128_ HMAC_SHA1_80
Application Rules RTP
Border Rules Encrypted RTCP [
Media Rules
. MK O
Security Rules
Signaling Rules Lifetime Any
End Point Policy Interworking
Groups

Session Paolicies

Video Encryption

> TLS Management Preferred Formats RTP

> Device Specific Settings
Interworking O

Miscellaneous

Capability Megotiation a

Edit

6.4.4. Endpoint Policy Groups

The rules created within the Domain Policy section are assigned to an Endpoint Policy Group.
The Endpoint Policy Group is then applied to Server Flow defined in Section 6.5.4.
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Endpoint Policy Groups were separately created for SP and EN.

To create a policy group, navigate to Domain Policies = Endpoint Policy Groups and click on the
Add button.

6.4.4.1 Endpoint Policy Group for SP

The following screen shows SP-PG created for SP.

Set Application Rule to SP-AR which was created in Section 6.4.2.1.
Set Media Rule to default-low-med.

Set Signaling Rule to SP-SR which was created in Section 6.4.1.1.
Set Border Rule to default.

Set Security Rule to default-med.

Session Border Controller for Enterprise AVAYA

4 Domain Policies Policy Groups: SP-PG
Application Rules

Add |Fi|ter By Device... ~ Rename Clone Delete

Border Rules

Paolicy Groups Click here to add a description.

Media Rules
Security Rules default-low Hover over a row to see its description.
Signaling Rules default-low-enc —‘
. . Policy Group
End Point Policy default-med
Groups

Summary

Session Policies default-med-enc

Order Application Border Media Security Signaling

default- '
SP-AR default et defaultmed  SP-SR Edit

> TLS Management EN-PG

- Device Specific Settings SPPG

6.4.4.2 Endpoint Policy Group for EN
Similarly, the following screen shows policy group EN-PG created for EN.

Session Border Controller for Enterprise AVAYA

4 Domain Policies Policy Groups: EN-PG
Application Rules

Add |Filter By Device... V| Rename Clone Delete

Border Rules

Media Rules Paolicy Groups Click here to add a description.

- default-low . L
Security Rules Hover over a row to see its description.
Signaling Rules default-low-enc —‘

. . Policy Group
End Point Policy default-med
Groups

Summary

Session Policies default-med-enc

Order Application Border Media Security Signaling

b TLS Management EN-PG

> Device Specific Seftings o EN-AR defaul EN-SRTP-MR  default-med  EN-SR Edit

6.5. Device Specific Settings

The Device Specific Settings feature allows aggregate system information to be viewed and various
device-specific parameters to be managed to determine how a particular device will function when

QT; Reviewed: Solution & Interoperability Test Lab Application Notes 46 of 56
SPOC 1/30/2017 ©2017 Avaya Inc. All Rights Reserved. TLSIPO10SBCE71



deployed in the network. Specifically, it gives the ability to define and administer various device-
specific protection features such as Message Sequence Analysis (MSA) functionality and protocol
scrubber rules, end-point and session call flows, as well as the ability to manage system logs and
control security features.

6.5.1. Network Management

The Network Management page is where the network interface settings are configured and enabled.
During the installation process of the Avaya SBCE, certain network-specific information is defined
such as device IP address, public IP address, subnet mask, gateway, etc., to interface the device to
the networks. This information populates the various Network Management tabs which can be edited
as needed to optimize device performance and network efficiency.

Navigate to Device Specific Settings = Network Management, under Interfaces tab, enable the
interfaces connecting to the inside enterprise and outside service provider networks. To enable an
interface, click on “Disable” Status. The following screen shows interface A1 and B1 were Enabled.

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: mSBCE
Administration

> TLS Management
] - : Devices Interfaces | | Networks |
4 Device Specific Settings

Network mSBCE
Management
Interface Name VLAN Tag Status
Media Interface: A E—
napled
Signaling Interface
End Point Flows B Enabled

On the Networks tab, verify the IP addresses assigned to the interfaces and that the interfaces are
enabled. The following screen shows the private interface was assigned to Al and the public
interface was assigned to B1 appropriate to the parameters shown in the Figure 1.

Session Border Controller for Enterprise AVAYA

Dashboard Network Management: mSBCE
* Global Parameters
> Global Profiles

. PPM Services Interfaces Network5|

m3BCE

Add

» Domain Policies

* TLS Management Gateway Subnet Mask Interface IP Address
14 Device Specific Settings
MNetwork_A1 10.10.97.129 255255266192 A1 10.10.97.176  Edit Delete
MNetwork
Management
Media Interface MNetwork_B1 10.10.98.97 255255266224 B1 10.10.98.103  Edit Delete

Signaling Interface

6.5.2. Media Interface

The Media Interface screen is where the media ports are defined. The Avaya SBCE will open
connection for RTP traffic on the defined ports.
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To create a new Media Interface, navigate to Device Specific Settings = Media Interface and
click on the Add Media Interface button (not shown).

Two separate Media Interfaces are needed for both the inside and outside interfaces. The following
screen shows the Media Interfaces InMedia and OutMedia were created for the compliance testing.

Note: After the media interfaces are created, an application restart is necessary before the changes

will take effect.

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
Global Profiles

> PPM Services

> Domain Policies

=

> TLS Management
4 Device Specific Settings

Network Management

Media Interface

Session Border Controller for Enterprise

Media Interface: mSBCE

Devices Media Interface

AVAYA

m3BCE

Modifying or deleting an

effect. Application restarts

Name

InMedia

OutMedia

isting media interface will require an application restart before taking
can be issued from System Management.

Add

ELERIS

Network

Port Range

10.10.97.176

Nebuar AT (A1, VLAN0) 35000 - 40000 Edit Delete

10.10.98.103

0098193 ) 35000-40000  Edit Delete
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6.5.3. Signaling Interface

The Signaling Interface screen is where the SIP signaling port is defined. The Avaya SBCE will
listen for SIP requests on the defined port.

To create a new Signaling Interface, navigate to Device Specific Settings - Signaling Interface
and click on the Add button.

Two separate Signaling Interfaces are needed for both inside and outside interfaces. The following
screen shows the Signaling Interfaces InsideSIG and OutsideSIG were created in the compliance
testing with TLS/5061 and UDP/5083 respectively configured for inside and outside interfaces.

Dashboard
Administration
Backup/Restore
System Management
> Global Parameters
Global Profiles

> PPM Services

> Domain Palicies

=

> TLS Management

4 Device Specific Settings
Metwork Management
Media Interface
Signaling Interface
End Point Flows

Session Border Controller for Enterprise

Signaling Interface: mSBCE

Devices Signaling Interface

AVAYA

m3BCE

Signaling IP TCP  UDP

Port Port

10.10.98.103
CutsideSIG \l‘:e‘lwut B1(B1, — 5083 —

InsideSIG \h:e’lwull: Al (AT, — — 5061

Modifying or deleting an existing signaling interface will require an application restart before

taking effect. Application restarts can be issued from Syste

Add

TLS Profile

None Edit Delete

AvayaSBCServer Edit Delete
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6.5.4. End Point Flows - Server Flow

When a packet is received by the Avaya SBCE, the content of the packet (IP addresses, URISs, etc.) is
used to determine which flow it matches. Once the flow is determined, the flow points to a policy
which contains several rules concerning processing, privileges, authentication, routing, etc. Once
routing is applied and the destination endpoint is determined, the policies for this destination
endpoint are applied. The context is maintained, so as to be applied to future packets in the same
flow. The following screen illustrates the flow through the Avaya SBCE to secure a SIP Trunk call.

“Call Server” — Trunk Server “Trurk
Call Sen Mcly 5 P
D e D Policy Group N Flow D Gfrpr olicy D
F
. ow =

“Call Server” *Trunk"Policy Trunk Server
<] Palicy Group <:| Sl Group <] Flow <]

In the compliance testing, two separate Server Flows were created for SP and EN.

a
1P-POX

SP Trunk Service Provider
o

To create a Server Flow, navigate to Device Specific Settings = End Point Flows, select the
Server Flows tab and click on the Add Flow button (not shown). In the new window that appears,
enter the following values while the other fields were kept as default.
e Flow Name: Enter a descriptive name.
e Server Configuration: Select Server Configuration created in Section 6.3.3 which the
Server Flow associates to.
e URI Group: Select “*”.
e Received Interface: Select the Signaling Interface created in Section 6.5.3 which is the
Server Configuration is designed to receive SIP signaling from.
e Signaling Interface: Select the Signaling Interface created in Section 6.5.3 which is the
Server Configuration is designed to send the SIP signaling to.
e Media Interface: Select the Media Interface created in Section 6.5.2 which is the Server
Configuration is designed to send the RTP to.
e End Point Policy Group: Select the End Point Policy Group created in Section 6.4.4.
e Routing Profile: Select the Routing Profile created in Section 6.3.4.
e Topology Hiding Profile: Select the Topology Hiding profile created in Section 6.3.5 to
apply toward the Server Configuration.
e Use default values for all remaining fields. Click Finish to save and exit.
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The following screen shows the Server Flow SP-SF for SP.

Edit Flow: SP-SF

Flow Mame

Server Configuration
URI Group
Transport

Remote Subnet
Received Interface InsideSIG
Signaling Interface OutsidesIG ~

Media Interface OutMedia

Secondary Media Interface Mone

End Point Palicy Group | SP-PG

Routing Profile EN-RP
Topology Hiding Profile SP-TH

Signaling Manipulation Script None

I
< <

Remate Branch Office Any

Finish
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Similarly, the following screen shows the Server Flow EN-SF for IP Office.

Flow Name

Server Configuration
URI Group
Transport

Remote Subnet
Received Interface OutsideSIG ~
Signaling Interface InsideSIG e

Media Interface InMedia

Insdesic ]

Secondary Media Interface None

1< ]

End Point Policy Group ‘ EN-PG

Routing Profile SP-RP
Topology Hiding Profile EN-TH

Signaling Manipulation Script None

I
E]
=
<
{
< <

Remote Branch Office
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7. Liechtenstein SIP Trunking Configuration

Liechtenstein is responsible for the configuration of Liechtenstein SIP Trunking service. The
customer will need to provide the IP address used to reach the IP Office at the enterprise, this
address will be the outside interface of the Avaya SBCE. Liechtenstein will provide the customer the
necessary information to configure the Avaya IP Office SIP connection to Liechtenstein. The
provided information from Liechtenstein includes:

IP address of the Liechtenstein SIP proxy.

Supported codecs.
DID numbers.

SIP Credentials

8. Verification Steps

The following steps may be used to verify the configuration:

IP addresses and port numbers used for signaling or media through any security devices.

e Use the Avaya IP Office System Status application to verify the state of the SIP connection.
Launch the application from Start > Programs > IP Office = System Status on the PC
where Avaya IP Office Manager was installed. Select the SIP line of interest from the left
pane. On the Status tab in the right pane, verify that the Current State is Idle for each
channel (assuming no active calls at present time).

AVAYA

Help Snapshot LogOff Exit About

|+

Line Number:

Mumber of Administered Channels:
Mumber of Channels in Use:
Administered Compression:

SIP Trunk Channel Licenses:
SIP Trunk Channel Licenses in Use:
SIP Device Features:

Status  tiization Summary Alarms

IP Office System Status

SIP Trunk Summary &
Line Service State: In Service
Peer Domain Mame: t00000d.convoip.li
Resolved Address: 10.10,97.176

2

10

0

G711 A, G729 A

Enable Faststart: off
Silence Suppression: off
Media Stream: Best Effort
Layer 4 Protocol: TLS

= @
1]

REFER {Incoming and Outgeing), UPDATE (Incoming and Outgeoing)
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e Select the Alarms tab and verify that no alarms are active on the SIP line.

IP Office System Status

Help Snapshot LogOff Exit About

Alarms

Status  Utilization Summary

Alarms for Line: 2 SIP t00000d.convoip.li

Last Date Of Errar

Ocourrences Error Description

Clear all Graceful Shutdown Force Out of Service Print... Save As...

e Verify that a phone connected to PSTN can successfully place a call to the IP Office with
two-way audio.

e Verify that a phone connected to IP Office can successfully place a call to the PSTN with
two-way audio.

e Using a network sniffing tool (e.g., Wireshark) to monitor the SIP signaling between the
enterprise and Liechtenstein. The sniffer traces are captured at the public interface of the
Avaya SBCE.

9. Conclusion

The Liechtenstein SIP Trunking passed compliance testing with any observations/limitations
detailed in Section 2.2. These Application Notes describe the procedures required to configure the
SIP connection between Avaya IP Office, Avaya Session Border Controller for Enterprise and the
Liechtenstein SIP Trunking service as shown in Figure 1.
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Product documentation for Avaya products may be found at http://support.avaya.com. Additional IP
Office documentation can be found at:
http://marketingtools.avaya.com/knowledgebase/

Product documentation for Liechtenstein SIP Trunking is available from Liechtenstein.
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full title name and filename, located in the lower right corner, directly to the Avaya DevConnect
Program at devconnect@avaya.com.
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